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Important Safety Information

Be sure to read all the safety information before you begin to use this product.

IMPORTANT NOTE: To reduce the risk of fire or shock hazard, do not expose this
player to rain or moisture.

CAUTION a This symbol indicates “'dangerous voltage"

inside the product that presents a risk of

RISK OF ELECTRIC SHOCK . .
electric shock or personal injury.

DO NOT OPEN

This symbol indicates important instruc-
tions accompanying the product.

RISQUE DE CHOC ELECTRIQUE
NE PAS OUVRIR

>

TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE THE COVER (OR
BACK). NO USER-SERVICEABLE PARTS ARE INSIDE. REFER SERVICING TO
QUALIFIED SERVICE PERSONNEL.

Sound Pressure Control

Les articles de loi L44.5 et 44.6 du code de la santé publique,

modifiés par I'article 2 de la loi du 28 Mai 1996 imposent une
DI puissance acoustique maximale de 100 décibels. Le casque livré
s.p.c ( code 55108920 ) et votre appareil respectent la Iégislation en
Sound Pressure Control Vigueur-

A pleine puissance, I’écoute prolongée du baladeur peut
endommager I'oreille de I'utilisateur.



Introduction

Your THOMSON Lyra personal digital player is designed to give you hours of
listening pleasure. To get the most out of your new purchase, we suggest that you
take a few minutes right now to read through this instruction manual.

If you have any questions or problems, consult the Troubleshooting Guide or visit
www.Thomson-Lyra.com for help and recent updates.
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Important Information

The THOMSON Lyra player works with your computer to let you play your favorite
music from files recorded on removable CompactFlash cards. The player plays files

encoded with the popular MP3, Windows Media™ Audio and RealNetworks** G2

audio formats and may allow for future upgrades of some alternative audio

compression formats.

Because the player has no moving parts, the audio can be played back virtually
anywhere without skipping.

You can download MP3, Windows Media and G2 encoded music files from several
Internet sites to your computer hard drive or record your favorite CD using the
software supplied.

Some of the Internet sites you may want to explore are:
WWw.emusic.com
www.real.com
www.musicmatch.com
www.mpeg.org
www.mp3.com
www.thomson-music.com

www.windowsmedia.com

Warning: Use of this product is for your personal use only. Copying CDs or
downloading music files for sale or other business purposes is a violation of
copyright law. It is also a violation of copyright law to download files
without permission of the copyright owner.

Caution While Driving: Use of headphones while operating an automobile or
moving vehicle is not recommended and is unlawful in some states and areas.
Be careful and attentive on the road. Stop operation of the unit if you find it
disruptive or distracting while driving.

Caution: Exposure to direct sunlight or extreme heat (such as inside a parked
car) may cause damage or malfunction.

Precautions for CompactFlash Card:

* Use a soft dry cloth to clean any dirt.

« Do not bend CompactFlash Card.

« Do not operate or store CompactFlash Card in places with frequent static
electricity as recorded data may be damaged.

< It is normal for CompactFlash card to get warm after being used for a long
time.

« Do not store CompactFlash card near fire, places with high temperature/
humidity or places with direct sunlight.

* Windows Media and the Windows Logo are trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.
**G2, Reallukebox, and RealNetworks are trademarks of RealNetworks, Inc.



Important Information

Computer System Requirements

Minimum

* Pentium 166 MHz or faster

* 32MB RAM

* Windows* 98 ,Windows Me or
Windows 2000

(Parallel Port also available for
Windows 95)

* 45 MB free hard disk space plus 1
MB for every minute of CD quality
music you store on your hard drive
* CD-ROM Drive

= USB Port

« Full Duplex Sound Card

Optimum
e Pentium Il 300 MHz or higher
e 64 MB RAM

e Windows 98SE, Windows Me or
Windows 2000

* 50 MB free hard disk space plus 1
MB for every minute of CD quality

music you store on your hard drive

e CD-ROM Drive

= USB Port

* Full Duplex Sound Card

* Internet Explorer 4.0 or more with
latest access

* Windows and Microsoft are registered trademarks of Microsoft Corporation in the United States and/or

other countries.



Getting Started

1. Unpack the player and accessories.

When you unpack your new player, be sure you have removed all the accessories
and information papers. The items shown below are packed with your player.

@ THOMSON
LYRa-

CompactFlash
(+ -0
Multi-Media Player "AA" Duracell Ultra CompactFlash
with Removable Belt Clip Batteries Removable Memory Card

24 A TNOSWOHL

Audio Line Cable To
Remote Control Software CD Connect To Your Hifi System

External Drive for

CompactFlash Card Headphones



Getti ng Started

2. Insert the included software CD into your CD-ROM
drive.

Use the software setup program on the included CD to install the CompactFlash
drivers, Music Management software, and User’s guide and documentation.

A. Turn on your computer and insert
the software CD. The THOMSON Lyra
Software Setup program will
automatically run.

Note: If the setup screen does not appear,
double click My Computer, double click
your CD-ROM drive icon, and double click
setup.exe. You can also click S| | Run,
then type D:\setup.exe (where D is the let-
ter of your CD-ROM drive).

D. Click Next to display the Select

B. Select THOMSON Lyra(PDP2211) Components screen

from Choose Player Dialog.
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C. Click OK to display the Welcome N TN |
Dialog.

3. Install the CompactFlash drivers.

A. Click the Install CompactFlash B. Click Install and follow the

Driver icon to display the Select onscreen instructions to install the

CompactFlash Device screen. USB drivers for the USB external
drive included with your THOMSON

Lyra player.

Note: If you wish to install parallel port
drivers, click Select and choose the type of
drivers you wish to install.

C. Restart your computer.
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4. Connect the CompactFlash external drive.

The external drive allows you to transfer MP3, Windows Media™ audio, or G2
files to the CompactFlash card. The drivers for this drive must be installed first so
Windows can find them when you connect the external drive.

Note: Actual items may differ
in appearance.

Attach to USB port of com-
puter. (Symbol on plug typi-
cally matches symbol on USB

port.) Yellow LED

A. Make sure you have installed the C. Windows will automatically install
USB drivers and that your computer the drivers for the CompactFlash drive
has been restarted. after you connect it.

B. Once the computer has been Note: Consult your computer or device’s
restarted, connect the CompactFlash owner manual for USB port specifications

external drive to an available USB and troubleshooting.

port of your computer as shown
above.

5. Install the music management software.

MusicMatch Jukebox and Reallukebox software are both on the CD. We
recommend MusicMatch Jukebox for ease of use and functionality. Both
software programs operate as players on your PC, compress CDs to MP3 format,
download files from the Internet, and transfer the files to a CompactFlash card
you can play on your THOMSON Lyra player. Download MP3 and Windows
Media™ audio formats to the player with the MusicMatch Jukebox software.
Download MP3 and G2 formats to the player with the RealJukebox software.
Install one or both of these programs.

Note: THOMSON Lyra player specific updates are available at www.thomson-lyra.com.
MusicMatch system requirements for the download are 166 MHz processor or better,
Windows 95 /98 / NT / 2000, 16 MB RAM (32 for NT), 30 MB hard drive, SVGA or higher
resolution monitor, 4x CD-ROM drive, mouse, keyboard, SoundBlaster compatible card,
speakers, video card and installation of Microsoft’s Media Player 6.4 for video.
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5. Install the music management software. ( continued)

A. Insert the THOMSON Lyra C. Select the software you want to
software disc into your CD-ROM install and click Install.

drive. Follow the directions under

Step 2 to display the Select * Select MusicMatch Jukebox
Components screen. (Recommended) to install the

MusicMatch Jukebox software.
MusicMatch Jukebox is capable of
MP3, WAV, and Windows Media™
audio format compression. Musical
content is provided by EMusic.com*,
the Internet’s number one source for
MP3s. EMusic’s content will be
installed with the MusicMatch
Jukebox software.

Go to Step 6.

* Select RealJukebox to install the
Reallukebox software. Reallukebox
is capable of MP3, wave, and G2

B. Click the Install the Music compression.
Management Software icon to

display the Select Music Software Go to Step 7.
screen.

e T <

*EMusic.com, the EMusic.com Logo and other proprietary names of EMusic.com are trademarks of
Emusic.com Inc.
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Install the MusicMatch Jukebox™ software.

A. Display the Select Music Software
screen as described in Step 5.

Make sure MusicMatch Jukebox is
highlighted and click Install.

QUICKSTART screen will appear after
installation has started. Click on
Install MusicMatch Jukebox 5.1.
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Click Yes to accept or No to decline
after you have read the license
agreement. You must click Yes to
continue.

When the next screen appears, enter
your Name, Email address, Postal
code, Country, Year of Birth, and sex
(Male or Female).
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Notes: Enter an Email address or
yourname@home.com if you don’t have
email. You must enter an email address to
proceed.

If you do not want to be informed of pro-
gram updates or receive news and offers
via email, uncheck the boxes.

B. Click Next to display Personalize
Net Music screen.
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Read the screen and decide if you
would like to enable the PERSONAL-
IZE NET MUSIC feature. Select Yes or

No. This setting can be changed later.
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Install the MusicMatch Jukebox™ software. ( continued)

C. Click Next to display Installation D. After the installation is complete,
Options dialog. Select the click Finish to complete setup.
installation option you wish to use.
Express Setup is recommended.
Click Next to continue.
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If necessary, close the main setup

T e screen.

You may need to restart your web
browser. Reboot your computer if
any other software was installed
specifically USB compact flash
drivers.

Set MusicMatch Jukebox basic preferences.

Detailed information, Welcome Tips, and troubleshooting are available
through the Help menu and the MusicMatch Internet site (accessed from the
Help and Sites menus). We recommend you familiarize yourself with the
MusicMatch Welcome Tips and view the Online FAQ’s before using and
recording files. Logging onto the Internet while using MusicMatch Jukebox
takes advantage of all its features.

We feel a few of the Recording Settings options need to be discussed before
you start using the MusicMatch Jukebox software.
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Set MusicMatch Jukebox basic preferences. (  continued)

A. Start the MusicMatch Jukebox software.

|
B. The Search for Music screen Note: You can access the Options menu at
appears asking if you want the almost any time by pressing the right
program to search for existing mouse button.
compatible music files.
S
T By e =
e rhu-ﬁ&ph“
MUSICREMATCH = oo 8
L
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Click OK, to have the files found o ey ey
appear in the Music Library. L e —— |
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C. Display the Settings menu by
choosing Settings under the Options
menu.
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Set MusicMatch Jukebox basic preferences. ( continued)

D. Click the Recorder tab to display the Recorder settings.

Settings .|

Generall Player FRecorder I Music Libraryl CDDBJConnectivitﬂ

- Recording Quality

= CD Quiality

o
™ \windows Media (128 kbps)
WAl Format

= MP3 (160 kbps) wloverzampling

Songs Directory. .. |
Advanced... |
Delayed Record... |
Security... |

—Mear CO Quality
 MP3 [36 kbps]
© Windows Media [95 kbps)

¥V Mute whils Recording

—Make Song Clips
™ Enable

—Fi Radio Quality
" MP3 (54 kbps)
© Windows Media [64 kbps)

St at I[I SEn
[Cermth IIZ' SEn

- LD Recarding Mode ——

— Custam Quality

" MP2YER e
" MP3ICER o
 Windows Meda }———

+

@ Digital
B ™ Eror Comection

48 kbps " fnalog
5 kbps

Recording Sowce [G: [MITSUMI CO-ROM Fx ¥

(0] I Cancel Help

E. Select the recording Quality level.

CD Quality MP3 (128Kbps) is the
recommended quality level.

MP3 and Windows Media formats
are supported by MusicMatch
Jukebox for the THOMSON Lyra
player.

* MP3 audio is MPEG

Layer-3 Audio available at various
encoding bit rate. The highest

bit rate has the best quality sound,
but uses the most disk space.
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* Windows Media™ audio is a
compression format created by
Microsoft. This audio format
incorporates digital rights man-
agement.

< WAV audio is unencoded music
that is not compressed. This
format has the best quality sound
but requires the largest file size,
as much as 650MB per CD. WAV
audio files are much larger than
MP3 audio files.

Note: Custom Quality settings are for
advanced users only.

Select a CD Recording Mode.

1. Check Digital and Error
Correction for the best results.
Error checking and correction will
be performed while you are
recording.

Note: Choosing Error Correction will
slow down your recording speed.

2. Check Analog if your CD-ROM
drive does not support digital
audio extraction.

Set MusicMatch Jukebox basic preferences. ( continued)

G. Select a default Recording
Source. If you have more than one
recording source, select the source
you record from the most.

H. Mute while Recording. This
feature allows you to mute the audio
while it is being recorded. Uncheck
this box to hear the audio as it is
recorded.

Note: This is not recommended as it will
decrease the recording speed.

13
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Learn the MusicMatch Jukebox basic controls.

Listed below are the basic functions of the main controls for the program.

Menus Playlist Controls
Options, Docks and Undocks
Register, Playlist Window

Sites and Help

Current Selection i PLAYLIST L=
Display Area =

PLAY Button (Press
to start playback. OPEN, SAVE, CLEAR,

and CD-R

PAUSE Button (Press . _
to pause playback) -' Playlist Window

PREV and NEXT
Buttons (Use to select
the next or previous
song in the playlist.)

STOP Button VOLUME
Control
Displays the Recorder Window
Displays the Music Library = . .
Window é Displays the Track Info Window

m Displays the Music Guide Window J Displays the Radio Window

Note: These secondary display windows normally attach to the lowest open window. You may need
to close, move, or open windows to view them.
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Save CD tracks to play on your PC or in your

THOMSON Lyra player.

A. Insert a CD into your CD-ROM
drive. If you are connected to the
Internet, MusicMatch Jukebox will
retrieve information about the CD in
the CD-ROM drive.

If you are on a LAN system and the
titling feature does not work, contact
your administrator.

Make sure the Enable CDDB CD
lookup service is selected on the
CDDB Preferences page if you are
able to make a connection to the
Internet. Choose CDDB Preferences
from Settings in the Options menu.

it | P | it | s b, E e |

B. The information from the Internet appears.

SLATLIET

o

If the information cannot be retrieved
from the Internet, enter it manually.
You can enter information or edit
existing information by clicking in the
desired box and typing.

Important Note: If the information
is not entered before recording,
default song names and information
will be used.

15
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Save CD tracks to play on your PC or in your
THOMSON Lyra player. (continued)

C. Press the REC button if the Recorder window is not open. Press REFRESH if the

songs are not listed.

Stop Cancel

Button

Button CD

HECCEDER

RECORD
Button

CD Info
Display Area

Eject

ALL

NONE  REFRESH

Button Button Button

il T Hai
[ ] i
[ et o v e e e 4
§ I Vo e i i
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I
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T ra
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A it e e mm

D. Select the tracks you want to
record.

« To start recording, click RECORD.
« To stop recording the current
track, click stop.

« To cancel the entire recording
session for all selected tracks, click
cancel

Song Selection Area

« To eject the CD, click eject CD.

« To select all songs, click All.

« To deselect all songs, click None.

« To refresh the track title information
or to attempt detection again, click
Refresh.

E. After recording is completed, the
songs will be stored in the Music
Library.

Download music from the Internet.

A. Click the MUSIC GUIDE button to connect to the MUSICMATCH MUSIC GUIDE

download site.

Notes: You can also select Show Music
Match Guide from View in the Options
menu to display this window.

16

If you have not established an Internet
connection, MusicMatch Jukebox will
attempt but fail to connect.

Music you download from the MUSIC
GUIDE window will automatically be
placed in the Music Library.

You can download files using your reg-
ular browser. Be sure to import (and/or
move) them into MusicMatch Jukebox.
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Use MusicMatch Jukebox to play Radio on your PC.

A. Click the Radio button to open the Radio window.

Note: You can also select Show MusicMatch Radio from View in the Options menu to dis-
play this window.

B. Click on STATION SELECTOR to « If you want to search for a certain
open the following window. station, use the SEARCH feature on
the bottom of the window.

[N, ¢ Ciick once on a station to display

e S "'|""“' it. Click twice on the station (or click
g il o . PLAY) to play music from the station.
= e | e

= e s The station you select appears in the
== el | - <= ==y Playlist.

= jprm = e

= [

e N D. To connect to the station’s web-

site, click the GO TO STATION’S
WEBSITE button on the bottom of

Click the button in the upper left cor- the Net Radio Window.
ner to toggle between FORMAT, CITY,
or COUNTRY to select the station you Note: If the station you select is not avail-

able, this is usually a temporary situation.

want to listen to. 5
Try again later.

* Select FORMAT to choose a station
by the type of music you like to listen
to.

* Select CITY to choose a station in a
certain city.

e Select COUNTRY to choose a sta-
tion in a certain country

17
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Organize the Music Library.

You can choose how to view your music library. You can select as many as seven
categories to display at one time.

A. Click the Music Library button from the Main window to display the Music
Library window.

Note: you can also select Show Music Library from View in the Options menu.

AUTO DJ
Button

ADD DELETE TAG FIND

Sort/View Button Button Button Button

Button

MU (IHEARF iy
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Emanliimd - Badld Sigwn v i Wbk e
L) Lot .t e iy 1oy P gy iy o
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N

Music Library Window

B. Setup the Music Library for your
preferences. Select Music Library from
Settings in the Options menu to
display the Music Library Settings
screen.
e T
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Select the number of columns and
type of information you want dis-
played in each, and then click OK.

C. The Music Library now displays
your selections. To sort by categories
click on the folder icon (sort/view
button) in the Music Library window.
to Select how you want to view your
songs.

MUSIC LIBRARY v
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D. To add a track from your Music
Library to your playlist, either double
click it or drag and drop it.
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Create a playlist for playing or downloading.

To create a playlist, you can drag and drop files from your Music Library
or you can open an existing playlist.

Undocks and Docks OPEN SAVE CLEAR
Playing Info Playlist Window Button  Button Button
N - CDR
e Button

PLAY ' -] (-
Button ", E

PAUSE

[
Button \F_

Displays =
Music Playlist

Library # Window

E
T el

ADD DELETE TAG FIND AUTO DJ
Button Button Button Button Button

Sort/View MUSA LIBEARY -
Button [ s s g e -

kT (] e i
rmon e Ve Epamska g [ s

F e Mg - o e s £
Emsnliiomd - Badld S vom i Wbl e
L) Lot . ey ey P gy i o
L =)
N

Music Library Window

A. To manually add tracks to the B. Click OPEN to open an existing
playlist, double click the track or drag  playlist, browse for tracks from a
and drop the track from the Music specific group, or play an audio CD.

Library into the playlist display.
C. To clear an entire playlist from the

To play a track before adding it to playlist window, click CLEAR.

the playlist, click 3] next to the

desired track in the Music Library D. To save your current playlist, click
window. SAVE. When the window appears, enter

a playlist name and click Save.
Note: Click to select a song, Shift and click
to select groups of songs, or Ctrl and click
to select multiple songs.
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Create a Playlist for playing or downloading. (

E. To remove a single track from the
playlist, click on the track to highlight
it, and then press Delete on the
keyboard.

Edit Tags for Your Songs

continued)

F. Click Play to play the songs from
the playlist. You can also double click
the song in the playlist to begin
playing.

You can edit or delete the tags for the tracks in your Music Library. If you delete
the track’s tag, all of the information about the track will be deleted.

ot kil b et et Pl i AL

Al L LI L

A. Highlight the track in the Music Library and click the Tag button to display the

Tag Song File window.

Note: Right click on the highlighted track to display a menu. Select Edit Track Tag

to display the Tag Song File window.
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B. You can edit the tag with your personal preferences for each of the tracks in

your Music Library.
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Transfer the audio files to the CompactFlash Card.

Use MusicMatch Jukebox to transfer music files to the CompactFlash card for the
THOMSON Lyra player. Make sure the external drive is installed properly and the

CompactFlash card is inserted.

Important Note

Removing the card
before the data is
completely written
may cause loss of the
entire contents of the
card and damage the
card.

A. Choose Options, Send to Device,
Download Playlist to Lyra to display
the Download To Lyra window.

===

BRRT = - —JE———
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B. Make sure Compact Flash is listed
in the Portable Device Memory area.

Note: If it is not listed, check all connec-
tions, click the Refresh button to refresh
the portable device memory list, make sure
the CompactFlash card is properly inserted
in the drive, restart your computer, and
consult online troubleshooting for possible
causes.

Note: Actual items may differ in
appearance from those shown.

Yellow LED

Insert card top first with front
(dogs) facing up.

C. Double click Compact Flash to see
what is recorded on the flash card.

D. Select the desired path for the
files. If you would like to create new
directories for your music, click g
to add a directory. Make sure the
correct folder is highlighted before
you start downloading.

E. Select and highlight the tracks you
want to download to the
CompactFlash card in the Files To
Download area.

Notes: If you remove and reinsert the
card, press Refresh to refresh the Portable
Device Memory list.

Click to select a song, Shift and click to
select groups of songs,

or Ctrl and click to select

multiple songs.
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Transfer the audio files to the CompactFlash Card.

(continued)

F. After you have selected all of the
music you want to record on the
CompactFlash card, click the
Download button on the bottom of
the screen.

File size and availability are listed in
the status and window displays.

Caution

The yellow LED on the
CompactFlash external drive
turns bright yellow when
files are being written to the
CompactFlash Card.

After the yellow light
dims, wait at least 5
seconds before removing
the card from the
external hard drive.

Removing the card before
the data is completely
written may cause loss of
the entire contents of the
card and damage the
card.

Note: Transfer all your MP3 or Windows
Media audio files in groups to prevent
reloading the appropriate driver for each
type and compression ratio.

G. Click Done when you are finished.

H. Click Exit under File in the Options
menu to close MusicMatch Jukebox.

I. Pull the card out to remove it
from the external drive.

J. Skip to page 34, Step 8 if you do
not want to install the Real Jukebox
software.

Information for installing the
RealJukebox software starts on the
next page.

Helpful Hints

For detailed information on
CompactFlash card file
management, creating
playlists, and grouping
management, please consult
the online documentation or
Help section.

The external drive can also be
used to transfer files from
digital cameras using
CompactFlash cards to the PC
or store files from the PC on
CompactFlash cards.

Note

MP3 files transferred to the CompactFlash card using THOMSON Lyra compatible
software are converted to an encrypted form for purposes of copyright protection, but
the encryption process does not change the MP3 encoding characteristics of the file or
the file's compliance with the MPEG-1, Layer 3 (MP3) standard. Additionally, the
original file is left unaffected on the user's system.
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7.

Install the RealJukebox software.

After you have installed the external drive and placed the THOMSON Lyra
software CD in the CD-ROM drive as described on pages 6-8, follow these
directions to install the Reallukebox software.

A. Display the Select Music Software
screen as described in Step 5.

Make sure RealJukebox is highlighted
and click Install.

B. Click Accept or Cancel after you
read the license agreement.

Note: You must Accept to continue.

C. When the Setup of RealJukebox
screen appears, verify the correct
destination path for the program
files.

[ o B ]|
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Click Next.

D. Select how to configure shortcuts
for RealJukebox and click Finish to

ey depacly
e iy

g 1 e e e
= e — e i

start installation of the software.

E. Once the RealJukebox software
has started, complete the Electronic
Registration Card. Enter your Country
and Zip Code. Click Next to proceed.
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Note: If you don’t have email, enter
yourname@home.com. You must enter an
email address to proceed.

F. Read Information about
Reallukebox window appears. Click
Tell Me More for more information or
click Next to continue.

G. Setup Options screen. Select the
setup option you wish to use. Express
Setup is recommended. Click Next to
continue.

H. Confirm Express Setup screen.
These screens will give a summary of
the most common and default
configuration settings. You can
change the settings or click Finish.

We suggest you click Finish and
not change any of the settings at
this time.

I. If necessary, close the main setup
screen.

Note: You can access the Configuration
Wizard from the Tools menu at any time
later when you are more familiar with the
program.
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Set basic preferences.

Detailed information, tutorials, and troubleshooting are available through the
Help menu and the Reallukebox Internet site (accessed from the Help and Sites

menus).

Note: We recommend you familiarize yourself with the RealJukebox New User’s Guide and
complete the Online Tutorial before using and recording files.

We also recommend that you log onto the Internet while using RealJukebox to
take advantage of all the features.

We feel the Recording Method and a few of the Audio Quality Preferences need
to be discussed before you start using the RealJukebox software.

A. Start the RealJukebox software. C. Click Recording to display the
Recording menu.
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B. Display the Preferences menu by
choosing Preferences under the Tools
menu. o
N .
[ 1 TR 1 e
il L B R T D. Select a recording method.
Eﬂﬁ“_ w
ks P 1. Check Digital and Use Error
e - Correction for the best results.
Sy | iy | Error checking and correction will
P be performed while you are
m“ln_unﬂw recording.
7 e ek g i B
R Wi Ay JR e Note: Choosing Use Error Correction
ettt s ek s e will slow down your recording speed.
L b e |
o | e |
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Set basic preferences. (continued)

2. Check Analog if your CD-ROM 3. Wave Audio is unencoded music
drive does not support digital that is not compressed. This format
audio extraction. has the best quality sound but
requires the largest file size, as much
E. With the Preferences menu as 650MB per CD. Wave Audio files
displayed, click Audio Quality to are much larger than RealAudio and
display the Audio Quality menu. MP3 Audio files.

G. Select a Secure Files setting

1. Secure Files On

Files recorded with security on
can only be played on the PC on
which they were recorded.

Note: If you record with the security
feature on, make sure you perform a
security key back up (Backup Security
Key feature located under Options
menu).

2. Secure Files Off
Most people choose to turn the

. Secure Files feature off.
F. Select a recording Format and

Quality Level. Notes: In the future, some music may
require the security feature turned on
1. RealAudio is RealNetworks’ to record to your computer.
audio format. This format saves
your music as RealAudio (.rmx) Turn this feature off if you own two
secure or RealAudio unsecured computers and exchange files

(.rmj) files. Compression levels between them.

available are (96, 64, and 44
Stereo, and 32 Kbps Mono).
96kbps Stereo has the best quality
sound, but uses the most disk
space.

3. Click OK.

2. MP3 Audio is MPEG layer 3
Audio available at multiple
compression levels from 32 kbps
mono to 320 kbps stereo. 320
kbps has the best quality sound,
but uses the most disk space. We
recommend using 128 kbps.

25



Getting Started

26

Learn the RealJukebox basic controls.

Listed below are the basic functions of the main controls for the program.

Play Stop Next Continuous

Button Button Button Play Button
Record Pause Previous Shuffle Play
Button Button | Button Progress Bar Button

000000 ———00

Volume Control

v [0 el G331 00

Selection : Rt

=k
1 1Chhbhan:

Program
Information
Display Area

P - T N

Save CD tracks to play on your PC or in your
THOMSON Lyra player.

A. Insert a CD into your CD ROM U
drive. If you have auto play/record e o ey i e
enabled, the CD will automatically P
begin playing and recording. e e [kt

L LT

I S s SR W S S

Note: If you do not want the CD to

automatically start playing or recording, Jrpem— - L Eye———
you can change the settings. e —

-I-ﬂ-r:-.-i-lr-l}n LR o lﬁﬂ:.
Choose Preferences in the Tools menu, e Gk e a3 A
and set the options for your personal E' i s T b b il

Folaasfenr 0 e o i g o bass
preference. I e b s mm g e gt il

b i iy i Py Prrm I
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Save CD tracks to play on your PC or THOMSON Lyra

player. (continued)

RealJukebox is an internet enabled
application and connects to the
Internet to retrieve information
about the CD in the CD ROM.

Make sure the Automatic CD Lookup

Information is selected in the Internet
Settings Preferences. Choose Internet
Setting from Preferences in the Tools

menu.
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If you are on a LAN system and the
titling feature does not work,
contact your administrator.

The information from the Internet appears on your screen.
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If the information cannot be retrieved from the Internet, enter it manually.

Important Note: If the information is not entered, titling and sorting
information will not be available in the library.

Press View Track Info for information on the artist of the track.
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Save CD tracks to play on your PC or THOMSON Lyra

player. (continued)

B. Select the tracks you want to play
or record.

« To start or stop playback, click play.

« To start or stop recording, click
record.

« To pause playback, press pause.

« To stop playback and recording,
press stop.

C. After recording is complete, the
songs will be stored in the Playlist.

L -

Download music from the Internet.

A. Click the Music Guide icon to have
RealJukebox connect you to the
Internet.

R
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B. Download the music you select to
your PC, and add it to your playlists.

Note: You can also download files using
your regular browser. Just be sure to import
(and/or move) them into RealJukebox.

You can also search the internet to
download the music you want
through the search mode.

A. Click the Search icon on the mode
selection row.

= ET @ 5
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|
A
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B. Key in information on how you
want the search to be done.
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Organize the Playlist.

A. All tracks can be grouped by B. Click Change Sub-Folders... to
Genre, Artist / Album, or all three. select the groupings, that you would
Choose Music Files from Preferences like to use for your music (any
in the Tools menu. combination of Artist, Album, or
Genre). Click OK.
_Z'I i —
il W |.Iul';nm 1 fotatluntiy e b e T i el o s e B
fiuid Abdar At | et 123 Taerwing. .. |-.- -. ] .|.. ﬂ
IR ditlal
@@ Tk Hudnr Tk Man: Tl mrrr
] e |
Thramer | My buociaacdkdinaa Wichaali srime sndLantirantill -
A il
- C. Click the Genre or Artist/Aloum
E = Sy Figr H H
M:-" — icon on the mode selection row to
—'m_ Fechwsran| view the groups of songs.
To play a song, double click it or
| o | highlight it, and press play.

Create a Playlist for playing or downloading.

A. Click the Playlist icon in the mode C. Press Add Tracks on the right

selection row. Click New Playlist but- hand side in Playlist mode. Click on

ton on the right of the screen. the song(s) you want to add to the
T — playlist so it is highligted. Press Add
M Tracks >> to store. Repeat this step

to enter additional tracks.

B. Fill out the Create Playlist form
to give specifications as to the name
of the new playlist, which tracks to
put into the playlist and the location Note: Click to select a song, Shift and click

where you want to put it. to select groups of songs, or Ctrl and click
to select multiple songs.
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Create an AutoPlaylist.

A. Click the AutoPlaylist icon in the
mode selection mode. Click New
AutoPlaylist button on the right of
the screen.

B. Fill out the Create a New
AutoPlaylist form to give
specifications as to how songs will be
organized in the the new Auto
playlist.

Searching for Tracks

A. Click on the Search button on the
mode selection bar.

T I e L —
- e RS R

L] L A

b= e e B e T e
o —

Click and highlight the the playlist
you want to edit. Click Edit
Autoplaylist on the right side column
to change preferences at any time.

All tracks saved on your PC will auto-
matically be placed in this folder if
track information follows specifica-
tions.

B. Click on the Search All Tracks
page.

C. Key in the music you want to
search for and Click Search Now to
begin search.
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Radio

A. Click on the Radio icon on the
Mode Selection bar.

B. Click on the Features page to
search for stations according to
Featured Genre or view Featured
Stations.

Click the Find Station page to search
the internet for the type of station
you like to find.

mﬂl
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A. Click My Stations to view stations
that you have bookmarked in the
past.

B. To add a station to your My
Station list, click on the [[J button
beside the station you want to store.

C. Your RealPlayer will automatically
open when you click on a station to
listen to the internet radio

Note: First time users of RealPlayer will
need to fill out the registration form to
personalize RealPlayer.

e s - Lo i
gl e ]
o o rame 3

-] =

e o8 il o —
[T ERSpNTS VI TI e |

31



Getting Started

32

Transfer the audio files to the CompactFlash card.

Use Reallukebox to transfer music files to the CompactFlash card so you

can take the music with you anywhere.

Important Note
Removing the card
before the data is
completely written
may cause loss of the
entire contents of the
card and damage the
card.

A. Make sure the external drive is
installed properly and the
CompactFlash card is inserted.

Note: If you remove and reinsert the card,

press F5 to refresh the Organizer directory.

Make sure your player is listed in the
Organizer under Devices / Storage.

B. Double click the THOMSON Lyra
icon to display the Flash Card icon or
click on n button beside Lyra on
the Organizer directory.

iy

L

Note: Actual items may differ in
appearance from those shown.

Yellow LED

Insert card top first with front
(dogs) facing up.

C. Double click the Flash Card icon to
see what is recorded on the flash
card.

[T P

D. Click the Add Tracks icon on the
right side column. Select the music
and click Add Track>> button on the
bottom.

Note: Click to select a song, Shift and click
to select groups of songs, or Ctrl and click
to select multiple songs.
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Transfer the audio files to the CompactFlash card.

(continued)

E. After you have selected all of the
music you want to record on the
flash card, double click the Flash Card
icon.

File size and availability are listed in
the status and window displays.

Notes: The card operates like a floppy
drive. The same drag and drop or copy
methods apply.

Transfer all your MP3 or G2 files in groups
to prevent reloading the appropriate
driver for each type.

F. Click the Begin Transfer button on
the right of the screen to download
your songs to the CompactFlash card.

Caution

The yellow LED on the
CompactFlash external drive
turns bright yellow when files
are being written to the
CompactFlash Card.

After the yellow light dims,
wait at least 5 seconds
before removing the card
from the external hard drive.

Removing the card before
the data is completely writ-
ten may cause loss of the
entire contents of the card
and damage the card.

G. Click Exit under the File menu to
close RealJukebox.

H. Pull the card out to remove it
from the external drive.

Helpful Hints

For detailed information on CompactFlash card file management, creating
playlists, and grouping management, please consult the on-line

documentation or Help section.

The external drive can also be used to transfer files from digital cameras using
CompactFlash cards to the PC or store files from the PC on CompactFlash

cards.

Note

MP3 files transferred to the CompactFlash card using THOMSON Lyra compatible soft-
ware are converted to an encrypted form for purposes of copyright protection, but the
encryption process does not change the MP3 encoding characteristics of the file or the
file's compliance with the MPEG-1, Layer 3 (MP3) standard. Additionally, the original file

is left unaffected on the user's system.
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8. Install the THOMSON Lyra user’s guide and
documentation.

After you have installed the external drive and placed the THOMSON Lyra
software CD in the CD ROM drive as described on pages 6-8, follow these
directions to install the THOMSON Lyra User’s Guide and documentation.

A. Display the Select Components C. Select the location for the
screen. program icons and click Next.

Click the Install the THOMSON Lyra

User’s Guide and documentation [T —— B
button. A
:'-'I- [ Ll L e ]
b"
pe 3
. -
=i - :
- I ='| I e |

D. Click Finish to complete the
installation.

B. Select the Destination folder
where you want the THOMSON Lyra
User’s Guide installed and click Next.

s Y T
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10. Insert the Duracell Ultra batteries into the player.

Battery Compartment Door
(Insert two Duracell Ultra "AA"

OPEN

batteries.)
\.
Before you can use the player, you must C. Close the door to the battery
insert two Duracell Ultra batteries. compartment.

A. Slide the battery compartment door Low Battery Indicator (:l )
in the direction of the arrow and lift The low battery indicator appears in
up. the LCD display when the batteries are
getting low. Replace the batteries.
B. Insert the batteries into the battery
compartment making sure the .
polarities (+ and -) are aligned correctly Fire and Snow-Jo
with the + and — markings in the com- di Ward

partment. 128K

NORMAL FLAT
Trk=03 & 1:38

Battery Safety Precautions

Any battery may leak electrolyte if mixed with a different battery type, if inserted
incorrectly, or if all batteries are not replaced at the same time.

Any battery may leak electrolyte if disposed of in fire or an attempt is made to
charge a battery not intended to be charged.

Discard leaky batteries immediately. Leaking batteries can cause skin burns or
other personal injury. When discarding batteries, be sure to dispose of them in
the proper manner, according to your state/provincial and local regulations.

Rechargeable Batteries

Risk of fire or explosion if the following is not observed:

Do not charge any battery other than PC202MH, PC204MH, or PC224 in this
equipment.

Do not use or charge the batteries if they appear to be leaking, discolored,
deformed or in any way abnormal.
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11. Insert the CompactFlash™ card in the player.

Before you use the digital audio feature, you must insert the removable card
with the MP3, Windows Media™ Audio or G2 music files into the player.

e

C(:mp:c[Fl:shcmé‘l’:ﬁryﬂcar: v i w F,

4(( E ) )

* yseloedwod
v

v

EJECT

OPEN

THOMSON
LYRa-

LCD Display | [ €%

(A.) Check to make sure the unit is turned off. (B) Insert the card top first
into the player with the front of the card facing the front of the player as
shown. Make sure the card is inserted fully into the player.

Caution: Do not force the card into the player as this may cause
damage to the card and/or player.

Note: To remove the card from the player, (A) turn off the player (B) slide

the eject lever on the back of the player with your thumb to eject the card.

12. Attach the headphones to the player.

Headphone Jack

(§2) \

THOMSON
LYRa-

Leo isplay | ™ €3)

Insert the plug on the headphone cable into the headphone jack (48 ) on

the top of the player and place the headphones on your head by fitting it
around your ears.
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Controls

CompactFlash memory card W
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Controls (continued)

1. Headphone Jack (§7)

Insert the plug from the headphone in
this jack on the top of the player.

2. RECALL MODE Button

e Selects Playback mode: Press to
select a playback mode (NORMAL,
REPEAT 1, REPEAT ALL, SHUFFLE,
REPEAT ALL SHUFFLE, PROGRAM, or
REPEAT ALL PROGRAM).

Press twice to adjust the contrast of the
LCD display.

e Contrast Adjustment: When in
stop mode, you can adjust the contrast
between the light and dark images in
the LCD display. Press the MODE
button twice to display the contrast
feature. Use the SELECT/VOLUME
control to adjust the contrast. Press
MODE or STOP to remove the display.

e Enter Station Recall Mode

3. DSP (Digital Signal
Processor) Button

In Digital Music Mode, press to select a
DSP mode: FLAT, BASS BOOST, ROCK,
POP, JAZZ, or EQ (equalizer). The
equalizer lets you cycle through five
frequency bands and adjust the gain of
the selected band for your personal
preference.

In Radio Mode, press DSP to toggle
between Bass Boost ON/OFF.

38

4. LIGHT Button

Press to turn light on and off in the LCD
panel. (Light turns off automatically
after approximately 7 seconds for every
press)

5. PLAY / PAUSE Button

« At player Off mode: Press once to
turn on player, press again to start
playback in digital music mode or turn
radio on. OR

Press and hold to return to the mode
last used before entering standby
mode.

* While player is playing: Press to
place the player in the pause mode.
Press again to return to playback.

* At tuner On Mode: Press to toggle
between Forced Mono and Stereo
reception modes.

6. SKIP / REW / TUNE Button

= While player is playing: Press once
momentarily to skip back to the last
track. Press and hold to search
backward within the same track.

* Player Stopped: Press to move the
cursor back to previous item.

« Player with Equalizer Displayed:
Press to cycle through the five
frequency bands of the equalizer. You
can adjust the gain of the selected band
with the SELECT/VOLUME control.

e Tuner On Mode: Press to tune
down radio frequency.
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Controls (continued)

7. SKIP / FWD / TUNE Button

« Player Playing: Press once
momentarily to skip to the next track.
Press and hold to search forward within
saved tracks.

* Player Stopped: Press to move the
cursor forward to an item.

« Player with Equalizer Displayed:
Press to cycle through the five
frequency bands of the equalizer. You
can adjust the gain of the selected
band with the SELECT/VOLUME control.

e Tuner On Mode: Press to tune up
radio frequency.

8. MULTI-FUNCTION SCROLL,
SELECT/ ENTER / VOLUME
CONTROL

« Player Playing: Turn the dial up or
down to adjust volume.

« Player Stopped: Turn the dial up or
down to move the cursor to an item.
Press this control in to select the item
for playing or adding/removing the
item to/from a program.

« Player with Equalizer Displayed:
Turn the dial up or down to adjust the
gain of a selected frequency band. The
band is selected with SKIP/REW or
SKIP/FWD.

9. STOP<OFF Button

« Player Playing: Press to place the
player in the stop mode.

* Player Stopped: Press to turn off
the player.

e Tuner On Mode: Press to return to
the Selection Menu or turn off the
radio.

* Press and hold to turn off player
from all modes.

10. LOCK / UNLOCK Button

* Slide button to LOCK position to
inactivate all buttons.

« Slide button to UNLOCK position to
release lock on all button functions.

11. Car Kit and AC Adapter
Plug (not included)

« Connect the car cord adapter and the
AC power adapter here.

12. Eject Lever

Slide lever in direction of arrow to
remove card from the player.

13. Belt Clip (Removable)

The removable belt clip attaches here.
14. Battery Compartment Door
Open door by sliding in direction of
arrow and lifting. Insert batteries
making sure polarities (+ and - ) are
aligned correctly.

15. Card Slot

Insert the removable card here top first
with front facing front of player.
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Remote control
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Connecting the Remote Control

* Plug the remote into the headphone
jack on top of the player.

CompactFlash memory card W
k ° o o o o ©° o J @
i@)
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1. Volume Control

2. Stop / Off Button

3. Play / Pause / On Button
4. Skip / fwd Button

5. Lock Button

Note: When using the remote control to
operate the player, it is best to lock buttons
on the main unit to avoid accidentally
pressing them.

« Shift the LOCK/UNLOCK button on the
main unit to the LOCK position. A lock key
icon will show on the LCD display. Only the
buttons on the main unit will be locked.
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Playing a CompactFlash Card

(Insert removable card top first --
front facing front of player)

yseoedwod
v Headphones Jack ( §8 )
v/
/7 = T
THOMSON
LYR&-
tp)t?tt)n . SELECT / VOLUME
LCD Display | [* Control
skip/rew play / pause skip/fwd stop-off( STOP«OFF
SKIP/REW \ % :
Button @ SKIP/FWD
tune recall S [ Button

1. Make sure batteries are installed in
the player.

2. Insert the headphone cable plug
into the headphone jack ( )on
top of the player.

Please refer to GETTING STARTED
NO.12 (pg 36) for further instructions

3. Insert the card encoded with MP3,
Windows Media Audio or G2 format
music files. Make sure to fully insert the
card.

Please refer to GETTING STARTED NO.
11 (pg 36) for detailed information on
inserting CF card.

4. Press PLAY to turn on the player.
The selection menu for DIGITAL AUDIO
or FM RADIO appears on the display.

rs
o
e,
i

oo
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Note: The unit will turn off to save battery
power automatically after 1 minute if no
buttons are pressed

Either:

1. Press ENTER dial to confirm selection
or

2. use SKIP/FWD or SKIP/REW skip to
select.

0l>Walking Fan-J
02 Don't See Me

03 Fire and Snow
O4 Atlanta-dJerry

NOTE: If DIGITAL AUDIO is selected and no
CF card is in the slot, you will remain in the
selection menu.

Remember that you MUST turn off the unit
completely to insert the CF card otherwise it
cannot be read.

Power On the unit again after the card is
fully inserted.

5. If you cannot see the display in
shaded or dark areas, press LIGHT to
turn on the light in the LCD display.

Note: The light will automatically time out
after 7 seconds if no buttons are pressed.
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Playing a CompactFlash Card

6. Press PLAY again to start playing the
first track in the list. Detailed
information about the track that is
playing appears in the LCD display.

Fire and Snow-Jo
di Ward

126K
NORMAL FLAT
Trk=03 1:38

The name of the song, artist, album,
playback mode selected, DSP mode
selected, number of the track playing,
and the elapsed playing time of the
track appear.

Note: The Volume bar, data rate and battery
indicators may also appear.

Search / Select Track in STOP Mode
To play a different track when the
player is stopped: Press SKIP/REW. or
SKIP/FWD or turn the SELECT/VOLUME
control up or down to move the cursor
down or up the list.

0l Walking Fan-J
02 Don't See Me
03 Fire and Snow
04 Atlanta-dJerry
05 Show the Mood
=1>Somewhere

Press PLAY to play the track.

(continued)

Search in Playback

To play the next or previous track while
the player is playing, press SKIP/REW or
SKIP/FWD.

7. During playback, adjust the volume
by turning the SELECT/VOLUME control
up or down. The Volume level selected
appears in the display.

Fire and Snow-Jo

id Ward
NORMAL 128K
FLAT

Volume=30

8. Press STOP«OFF to place the player
in the stop mode. The playlist will
show on the display

Note: After approximately one minute
without key activation, the player will turn
off to conserve batteries.

9. Press STOP=OFF again to return to
the selection menu.

or

Press and hold STOP<OFF to turn off
the player.

10. Press STOP=OFF from the selection
menu and the player will power off.

Cautions: Headset Safety

volume or discontinue use.

illegal in many areas.

situations.

Do not play your headset at a high volume.
Hearing experts advise against continuous extended play.
If you experience a ringing in your ears, reduce the

Do not use the headphones while operating a motorized
vehicle or bicycle. It may create a traffic hazard and is

Use extreme caution or temporarily discontinue use in potentially hazardous
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Player Features

Playback Features

e — £
THOMSON
LYR&a
SELECT/
VOLUME
PLAY / PAUSE Control
Button o

SKIP/REW

skip/rew play / pause skip/fwd

Button

tune recall tune

@ @ SKIP/FWD

lock
unlock

EB Button

© 0o 0o 0o o 0o o
© 0 0o 0o o 0o o
© 0 0 0 © o o
© 0o 0o 0o o 0o o
© 0 0o 0o o 0o o
© 0o 0o 0o o 0o o
© 0 0 0 © o o

Pause Feature

During Digital Music playback, you
can pause the player and mute the
volume.

* Press PLAY during playback to
pause the player. PAUSE will flash
on the display.

Note: If the player is left in pause for
approximately one minute, it will turn
off automatically. Press PLAY to activate
the auto resume feature.

e Press PLAY again to resume
playback.

© 0 0o 0o o 0o o
© 0o 0o 0o o 0o o

Auto Resume Feature

The player will automatically turn
off if no buttons are activated for
approximately one minute. The
player will retain the following
information and setting if the
same card remains in the player.

* Play/repeat mode selected

* Track play list

* Volume control setting

* Last track played information
* DSP and equalizer settings
Press PLAY to resume playback

from the track the player was
paused.
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Player Features

Playback Features
Skip and Search Features

Skip Feature

When the file list is displayed,
SKIP/FWD and SKIP/REW. or the
SELECT/VOLUME

control allows you to select which track
to play using the file list.

* Press SKIP/FWD to move the cursor
down the list.

* Press SKIP/REW to move up the list.

Note: If you search beyond the last
track, the cursor will return to the first
track.

Press PLAY to play the selected track.

During playback or pause, press and
release SKIP/FWD or SKIP/REW to skip
to the next or previous track.

* Press SKIP/FWD to skip to the next
track.

* Press SKIP/REW to skip to the begin-
ning of the current track being played.
Press again to skip to the previous
track.

Note: If you skip the last track, you will
return to the first track in the list.

Search Feature

During playback, SKIP/FWD . and
SKIP/REW. allow you to audibly search
through the tracks at a faster speed.

* During playback, press, hold and
release SKIP/FWD to search forward at
a faster speed.
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« During playback, press, hold and
release SKIP/REW to search in reverse
at a faster speed.

Notes:

If you search in reverse beyond the
beginning of the playing track, the
player will start playing the track you
select automatically.

If REPEAT 1 is activated, you can not
reverse beyond the selected track. The
player will start playing the repeating
track.

Scroll Feature

When the player is stopped, you can
scroll down the list of tracks by turning
the SELECT/VOLUME control up or
down.

Note: If you continue to scroll down
the list beyond the last track, the
player return to the first track on the
list.

1. Place the player in the stop mode.

2. Turn the SELECT/VOLUME control up
or down to scroll through the list of
tracks available on the card inserted in
the player.

3. Turn and hold the SELECT/VOLUME

control up or down for more than one
second for continuous page up or page
down.



Player Features

MODE Menu

You can use the MODE menu to select several playback features (REPEAT 1, REPEAT
ALL, SHUFFLE, REPEAT ALL SHUFFLE, PROGRAM, and REPEAT ALL PROGRAM). These

are described on the next two pages.

— —

/7

@ THOMSON
LYRa

MODE —
Button

skip/rew play / pause skip/fwd

tune recall tune

lock
unlock

© 0000 o00O0O0

Repeat and Shuffle Features

1. Place the player in the stop mode,
and press MODE to display the MODE
menu.

» NORMAL
REPEAT 1
REPEAT ALL
SHUFFLE
PROGRAM
LINE OUT

Moo X

2. Press SKIP/FWD or turn the
SELECT/VOLUME control to move the
cursor to the feature you want to
select.

* Select REPEAT 1 to repeat one track
over and continuously.

e Select REPEAT ALL to play all the
tracks in the selected playlist over
continuously.

* Select SHUFFLE to randomly play up
to 20 tracks. No tracks will be
repeated.

« Select REPEAT ALL SHUFFLE to play
tracks randomly with repetition.

Note: A cursor will appear before
REPEAT ALL and SHUFFLE.

3. Press the SELECT/VOLUME control in
to select the mode or the player will
select the mode next to the cursor after
five seconds.

Notes: Pressing PLAY also starts the
player playing with the selected
feature.

When the player is playing, you can
cycle through the playback modes by
pressing MODE then SKIP/REW or
SKIP/FWD. The mode selected appears
in the display.

Fire and Snow-Jo
di Ward

128K
SHUFFLE FLAT
Trk=03 1:348

Program Feature

1. Display the MODE menu, and press
SKIP/FWD to move the cursor to
PROGRAM

NORMAL
REPEAT 1
REPEAT ALL
SHUFFLE

» PROGRAM
LINE OUT

Moo X

2. Press the SELECT/VOLUME control in
to display the list.

0l Walking Fan-J
02 Don't See Me
03>Fire and Snow
O4 Atlanta-dJerry
05 Show the Mood
Ok Somewhere In
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Player Features

MODE Menu (continued)

Press SKIP/FWD ,SKIP/REW or turn the
SELECT/VOLUME up or down to move
the cursor to the first track you want in
your program. Press SELECT/VOLUME in
to select a track. A program mark P
appears in front of the selected track.

Note: To remove a track from the
program, move the cursor to the track
and press in the SELECT/VOLUME
control.

3. Continue to mark the tracks in the
order you want them to play (up to 20
total).

Note: If you try to select more than 20
tracks, the message MEMORY FULL
appears.

4. Press PLAY to start the program
playing.

Fire and Snow-Jo
di Ward

128K
PROGRAM FLAT
Trk=03 1:38

5. Press MODE to select PROGRAM REP
to have the program keep repeating
over and over.

Fire and Snow-dJo
di Ward

128K
PROGRAM REP FLAT
Trk=03 1:38

6. Press PLAY to pause the program.
Press STOP<OFF to stop the program.
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To Clear Programs from
Memory

1. Press STOP.

2. Press MODE.

3. Select PROGRAM. A message will
appear and ask if you want to clear all
programs. Select YES to clear program
by turning the SELECT/VOLUME contol
button.

4. Press ENTER in to confirm selection.

LINE OUT

Select LINE OUT to play music through
other Hifi systems.

1. Place the player in the stop mode,
and press MODE to display the MODE
menu.

2. Scroll down to LINE OUT by turning
the SELECT/VOLUME control.

* When in LINE OUT, other mode
options can also be selected when you
continue to scroll through the menu.

>NORMAL
REPEAT 1
REPEAT ALL
SHUFFLE
PROGRAM

»LINE OUT

Moo=

3. Press ENTER to confirm selection.



Player Features

DSP (Digital Signal Processor) Menu

You can use the DSP menu to select several DSP modes (FLAT, BASS BOOST, ROCK,

POP, JAZZ) or adjust the equalizer (EQ).

~ —

THOMSON
LYRa-
max
vol.
DSP  — min
Button skip/rew play/ pause skip/fwd _[|Stop-off
lu;xe m.ne ok
DSP Modes

1. Place the player in the stop mode,
and press DSP to display the DSP menu.
You can select FLAT, BASS BOOST,
ROCK, POP, JAZZ, or use the equalizer
(EQ) to personally adjust the sound.

ROCK
POP
JAZZ
EQ

PFLAT
BASS BOOST g
P

2. Press SKIP/FWD or SKIP/REW to move
the cursor to FLAT, BASS BOOST, ROCK,
POP, or JAZZ.

Note: If you select EQ (equalizer), the
equalizer menu appears.

3. Press the SELECT/VOLUME control in
to select the DSP feature. The player

returns to the file list.

Notes: Pressing PLAY also starts the

player playing with the selected feature.

When the player is playing, you can
cycle through the playback modes by
pressing DSP. The mode selected
appears on the display.

Ice and Snow-Joe
Jones

128K
NORMAL Eq
Trk=03 1:38

Equalizer Feature

1. Display the DSP menu, and press
SKIP/FWD to move the cursor to EQ
(equalizer).

FLAT

BASS BOOST D

ROCK

POP

JAZZ
PEQ

o

2. The EQ (equalizer) display will
appear in approximately one second.

FRE® 1K

+

0

0DB

* Press SKIP/FWD or SKIP/REW. to select
one of the five frequency bands (60,
250, 1k, 4k, and 12k).

* Turn the SELECT/VOLUME control up
or down to adjust the band (+15dB to
-15dB).

Note: Press the SELECT / VOLUME
control in to reset the band to 0.

3. Press PLAY to start playback with the
adjustments you have selected.
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Player Features

Radio Mode

RECALL
Button

DSP
Button

SKIP/REW
Button

THOMSON
LYR&-

skip/rew play / pause skip/fwd

Multi Function
Scroll

o N—— (SELECT/ ENTER /

VOLUME Control)

STOP-OFF
Button

PLAY
Button

RADIO Mode

1. Press the PLAY to turn on the

player

2. Selection Menu for Digital Audio
and FM Radio appears on the LCD

3. Press SKIP/REW or SKIP/FWD to
select by highlighting the Radio icon.
4. Press PLAY to confirm selection.

lock
unlock

SKIP/FWD Button

Search Features

* Press SKIP/FWD or SKIP/REW for
manual tuning to step forward / back-
ward in radio frequency.

* Press and hold SKIP/FWD or

I

].I MHz
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SKIP/REW for more then 1 second and
release for SEEK UP / DOWN mode.
Search continues until a station is
found.

e Press and hold SKIP/FWD or SKIP/REW
for more then 3 seconds for SCROLL UP
/ DOWN mode. Search will only stop
when the button is released.

Preset Memory

« 15 Memory spaces are available for
storing channel frequency.

1. Press SKIP/FWD or SKIP/REWto select
the desired station you want to store.
2. Push ENTER to enter the Program
menu. The player will automatically
locate an available memory location.

MEMORY 1.01.3MHz
1 98.1 MHz

2 > EMPTY

3 99.1 MHz

4 99.5 MHz
"Enter™ to Store




Player Features

Radio Mode

Preset Memory (cont’d)

3. Turn the multi-function scroll (select)
button or press SKIP/FWD or SKIP/REW
to select the desired channel number (1-
15) you want to store in.

4. Push ENTER to confirm storage and
exit Program mode

NOTE: Program Mode will
automatically exit if no buttons are
pressed for 10 seconds. In this case,
the station will not be stored.

OR Press DSP / PLAY to exit Program
Mode sooner without storing the
station.

NOTE: Press DSP / PLAY to exit program
mode will not change settings in radio
mode.

FM qq . 1I MHZ]
B'ASS M-1

[ I O R
a8 108

Memory Recall

e Press MODE / RECALL to browse the
15 channel memory locations.

* Turn the multi function scroll or press
SKIP/FWD or SKIP/REW to tune to a
preset channel.

RECALL

1 98.1 MHz

2 > 98.5 MHz

3 99.1 MHz

4 99.5 MHz
"Enter™ To Exit

NOTE: Recall will automatically exit if
no buttons are pressed for 10 seconds.
OR Press ENTER / PLAY to exit recall
mode sooner

Delete Preset Memory

1. Press MODE / RECALL to view the
current Preset Memory list.

2. Turn the dial or press SKIP/FWD or
SKIP/REW to select the preset memory
you want to delete.

3. When the desired one is selected,
press and hold MODE / RECALL for 2
seconds to delete.

4. “EMPTY” will show beside the
memory location that was cleared and it
will tune to the next stored frequency.

RECALL
L 98.1 MHz
c EMPTY

3 > 99.1 MHz
4 99.5 MHz
"Enter™ to Exit

Suppressing Stereo Signal

* Press PLAY to toggle between FM
mono and stereo for stereo FM stations.
A stereo indicator will appear when in
stereo mode.

DSP (Digital Signal Processor)

* Press to select Bass Boost ON/Off.
Bass indicator will appear when Bass
Boost is on.

STOP Feature
e Press STOP / OFF to return to the
Selection Menu.

* Press STOP / OFF again to turn off
the player.

OR

* Press and hold to turn off player.

49



Included Accessories

CompactFlash™ Memory Cards

The player uses Type | and || CompactFlash memory cards. Make sure you use only
these cards. Use of the wrong card could damage your player or CompactFlash Card
reader.

The cards can be used over and over again. Use Music Match Jukebox or Reallukebox
to delete the old tracks and then transfer the new tracks to the card.

Storage: CompactFlash cards can store approximately 2 minutes of audio per MB at
an MP3 bit rate of 64 kbps.

Insert removable card
top first --front facing

' useloedwo) front of player.

v
< el

THOMSON \ (ﬁ W b
LYR& ) Attach Belt
‘ Clip Here
Eject Lever
(Slide in direc-

& Removable belt
clip. Fit the belt
clip into the slot

LCD Display
tion of arrow to
eject card.)

skip/rew play / pause skip/wd

until it is snapped
we wne in place .
oo :Erz;{;%ﬂ;?g":\ : :
Inserting a Card Removing a Card
Insert the card with the top first and Turn the player off. Slide the eject
the front of the card facing the front lever in the direction of the arrow to
of the player as shown. Make sure the eject the card from the player.

card is inserted firmly.
Notes: Refer to the troubleshooting

Do not force the card into the guide on page 52 if you have any
player as this may cause damage difficulty playing, reading, or writing
to the card and/or player. to the card.

Removable Belt Clip

The player has a removable belt clip. Fit the belt clip into the slot on both sides of
the player. You should hear a “click” sound when it is locked in place. Make sure to
attach the belt clip firmly before using it to carry your player.
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Specifications

Player

Size: (H) 10.44 x (W) 6.35 x (D) 1.91 centimeters

Weight: 90.72 grams without batteries or memory card

Solid state memory

Batteries: 2 Duracell Ultra Batteries "AA™

Signal-to-noise ratio: > 70 db (MP3 mode) 55db (radio mode)

Slot: 1 external CompactFlash slot:
supports Type | or Type || CompactFlash cards.

Connectors: Headphone, DC Jack

CompactFlash Card Reader / Writer
« Universal Serial Bus (USB) Transfer Rate: up to 8 Mbps

The descriptions and characteristics given in this document are given as a general indication and not as a guarantee. In order

to provide the highest quality product possible, we reserve the right to make any improvement or modification without prior

notice. The English version serves as the final reference on all product and operational details should any discrepancies arise in

other languages.
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Troubleshooting Guide

Trouble

Checks and Adjustments

No power to external
drive

* Check all connections. See page 4.
« Make sure computer is turned on and plugged into an
operating outlet.

Player does not operate

* Batteries may be weak. Install new batteries.

= Remove batteries and hold down one or more buttons for
several seconds to drain the microprocessor inside the player to
reset it. Reinstall the batteries and try player again.

CompactFlash card will
not play or you cannot
insert it all the way into
the player

= Make sure card is inserted correctly into player--top facing in
and front facing the front of player. Do not force.

= Card is not encoded with compatible audio format (MP3, G2,
or other compatible format).

« Card may be damaged.

* Card may need to be defragmented (or reformatted--this
will erase all data on the card).

Player repeats same track
or all tracks

= Repeat play is turned on. Press MODE to change the play
mode.

Player plays tracks in ran-
dom order

« Shuffle play is turned on. Press MODE to change the play
mode.

* Program play is turned on. Press MODE to change the play
mode.

Player plays audio with
DSP sound

« Press DSP to change the DSP mode. Make sure equalizer is
set to your preferences.

Player pauses during play

* Press PLAY to resume playback.

Long delay between
songs

* May be alternating between MP3 and other formats. Try
grouping songs by format, and then transfer the files.

Songs not in same order
as CD

= Songs are listed in order they were transferred to
CompactFlash card.

Audio distorted at high
volume

* In equalizer mode, reduce the BASS gain.
« Switch from BASS BOOST mode.
* Reduce volume.

Player displays ""Config
File Not Found"

« Transfer files to CompactFlash card using MusicMatch
Jukebox or Reallukebox software.

Poor radio reception

* Ensure headphones are plugged in the plug.

= Straighten the headphone cord and re-orient the cable
« Turn off nearby electrical appliances, such as hair dryer,
vaccuum cleaner, microwave, flurescent lights.

* Press PLAY to switch to FM mono.

Radio auto search does
not stop

* Move to another area for stronger signal reception
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Lyra Helpline

EN
More help is available on www.thomson-lyra.com and phone numbers of the Lyra -
helpline per countries are listed below.

¢ HELPLINETHOMSON

Votre Contact THOMSON: 0 810 810 891, de le 16.10.2000
(pour la France, prix d'un appel local)

Ihr Kontakt zu THOMSON: 0180 1000 390, ab 16.10.2000.
(fir Deutschland, Kosten zum Ortstarif)

You can contact THOMSON by dialling: 0845 601 3093, from|6 October 2000
(For Great Britain, all calls will be charged at local rate)
Para contactar con THOMSON marque: 901 900 410, a partir del 16.10.2000
(las llamadas seran cargadas al precio de la tarifa local)
Il vostro contatto THOMSON: 8488 10 168, dal 16.10.2000
(tariffa chiamata urbana)

www.thomson europe.com
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